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Chapter 1: Introduction

Introduction
The Linksys One IP Phone User Guide introduces you to your Linksys One IP phones and 
provides detailed procedures for using and personalizing your phone settings.

About this Guide

The following topics are covered in this guide:

• Chapter 1 "Introduction" describes how this guide is organized.

• Chapter 2 "Getting to Know Your Phone" provides an overview of your phone system.

• Chapter 3 "Using Your Phone" describes the feature and control buttons on your phone.

• Chapter 4 "Using Voice Mail" provides procedures for accessing personal and system 
voice mail

• Chapter 5 "Using Your User Page" provides procedures on customizing your phone 
settings such as auto dials and call forwarding.

• Chapter 6 "Using the Auto Attendant" provides procedures for managing the auto 
attendant.

Related Documentation

Refer to the PHM1200 and PHB1100 Quick Reference Guides on www.linksysone.com/linksysoneproducts 

NOTE: Each phone comes with a 
Quick Reference Card. Be sure to refer 
to the Quick Reference Card for the 
most commonly used features on the 
phone.
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Chapter 2: Getting to Know Your Phone

Getting to Know Your Phone
The Linksys One IP phones PHM1200 and PHB1100 are wired desktop phones that provide 
voice communication over the internet. In addition to the phone features you have come to expect 
from a traditional phone, the Linksys One IP phones also provide:

• Simple automated installation with your Services Router

• Call processing features with integrated Voice Mail and Auto Attendant

• Online control of custom phone features and settings via a User web page

This section provides a detailed overview of your IP phone. It describes the function of each 
phone button and provides instructions on navigating your phone. The following topics are 
covered:

• ”Understanding Phone Buttons” on page 4

• ”Understanding the Phone Screen Interface” on page 5

• ”Understanding Line Buttons” on page 6

• ”Understanding Your Phone Passwords” on page 7
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This table describes the phone buttons on your IP phone. See the button illustration shown at right:

Description

1 Phone screen serves as your phone “desktop.”

2 Intercom buttons are available for handling calls inside your company. 

3 The button template lists your intercoms, outside lines, and feature button assignments. 
 

4 Outside line buttons provide access to the external phone lines assigned to you. Use 
these buttons to place and receive calls outside your company.

5 4 Softkeys.

6 5-position key (PHM1200) OR 3-position navigation key (PHB1100).

7 Feature buttons provide quick access to assigned phone features.

8 Hold button puts a call on hold.

9 Display shows button layout (PHM1200) OR the phone’s IP and MAC address (PHB1100).

10 Cancel button cancels the current phone task and displays the previous screen. 

11 Phone key pad allows you to dial a phone number and interact with Voice Mail and Auto 
Attendant systems. 

12 Microphone button mutes (red) and unmutes the microphone. 

13 Volume control adjusts the volume for the handset speaker and the speakerphone. 

14 Speakerphone button enables hands-free calling via the speakerphone or headset. This 
button turns green when the speakerphone is on. 

15 Phone speaker provides hands-free listening.

16 Handset. 

17 Voice Message Indicator turns red when you have a voice mail message. 

13

14

15

16

17

Linksys On

Linksys O
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Chapter 2: Getting to Know Your Phone
Understanding the Phone Screen Interface

Understanding the Phone Screen Interface
PHM1200 IP Phone

Your phone screen provides access to all calling functions and phone settings. The top of the 
phone screen displays the current date, time and call state; the bottom of the screen displays 
the Calls tab and Tasks tab. Select the Calls tab to place and handle calls and select the 
Tasks Tab to view call history, view the button template and access voice mail settings.

Navigating the Menus

If you want to... Then...

Select an item on the screen 1. Use the arrows on the navigation dial to scroll 
through menus and tabs.

2. Press the center button on the navigation dial to 
select a highlighted item.

Go back to the previous screen or exit a 
screen

Press the Cancel button.
On the Voice Mail and the Auto Attendant screens, 
you can also press the left navigation button to go 
back to the previous screen.

Erase text on a screen Press the left arrow on the navigation dial to erase 
digits you enter on the screen.

Select a softkey tab Press the button directly below the softkey tab.

Call State

Idle

Outgoing ca

Incoming cal

Call connecte

Call on hold

Error

Conference c

Call proceed
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PHB1100 IP Phone

Your phone screen displays phone settings, the current date and time, and the call state. See 
Call State Lines
6 Cha

the phone screen icon descriptions at right

Understanding Line Buttons
Intercoms:

• Intercom lines are used for making calls to extensions inside your office. 
They are accessed from the top left feature buttons on your phone.

• The number of Intercom lines is configured by your phone administrator.

External Lines:

• External lines are used for making outise calls. These lines are accessible
from the top right feature buttons.

• The number of lines, which lines (and if the line is shared or private) is configured by 
your phone administrator.

Shared Lines:

•   Shared lines allow mutiple users to access the same line. Incoming calls ring all phones  
 that share the line, and the line button on each phone flashes red.

• When a shared line is in use, the line button on the other phones that share the line are 
red.

• You cannot make a call on a shared line that is in use.

Idle

Outgoing call

Incoming call 

Call connected

Call on hold

Error

Conference call

Call proceeding
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Chapter 2: Getting to Know Your Phone
Understanding Your Phone Passwords

Understanding Your Phone Passwords
Here is a list of default passwords that you will use to access phone features. Some features 
may not be available to you and must be enabled by your phone administrator for you to 
access.

Feature/Action User How to Access Default Password

Manage Personal 
Voice Mail

All users with a 
personal voice 
mailbox.

• Dial user extension +100 
OR

• Press the Voice Mail 
feature button.

See ”Managing Your 
Personal Voice Mailbox” on 
page 25.

User extension +100. 
This is the same password 
used to access your User 
page.

Note that if you change 
this password, you are 
also changing the 
password for your User 
page.

Manage System 
Voice Mail 

Users who have 
access to the 
System Voice 
Mailbox.

• Dial extension 301 OR

• Press the System Voice 
Mail feature button.

See ”Accessing Your System 
Voice Mailbox” on page 28.

301 is the default 
password.

Call the Auto 
Attendant 

All users Dial extension 201.

See ”Accessing the Auto 
Attendant” on page 35.

No password needed.

Manage the Auto 
Attendant

Users who have 
access to the 
Auto Attendant 
greetings.

• Dial extension 209 OR

• Press the After Hours 
feature button

See ”Managing the Auto 
Attendant” on page 35.

209 is the default 
password.
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U

Access User Page All users Enter the following URL:
https://192.168.10.1

See ”Login To Your User 
Page” on page 29.

User extension +100.

Your User page password 
is also used to access your 
Personal Voice Mailbox. 
Therefore, if you change 
this password, you are 
also changing the 
password for your 
Personal Voice Mail.

Call the Operator All Users Dial 200

If no operator answers, the 
call is sent to the system 
voice mail.

See ”Managing Operator 
Calls” on page 39

No password needed.
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Chapter 3: Using Your Phone
Understanding your Phone Features

Using Your Phone 
Your Linksys One IP phone includes a range of features for call handling.This section 
describes your phone’s features and how to access them using the feature and line buttons 
on your phone. This section also describes the features you can access on your PHM1200 IP 
phone screen. The following topics are covered:

• ”Understanding your Phone Features” on page 9

• ”Using Your Phone Screen” on page 17

Understanding your Phone Features
Your phone includes line and feature buttons that allow basic phone tasks such as placing, 
answering and transferring calls. Your phone also supports advanced call handling features 
that may not be available to you and must be enabled by your phone administrator.

Placing a Call

If you want to... Then...

Place an Internal Call 1. Do any of the following:

• Lift the handset and press an intercom button.

• Press an intercom button to use the speakerphone.

• Press the Auto Dial button (see ”Using Auto Dial” on 
page 15).

Place an Outside Call 1. Lift the handset, the phone goes off-hook on a line OR 
simply press an outside line button to use the speakerphone.

2. Dial the phone number. The number of digits to dial for 
outside calls varies, depending on the dial plan options 
selected for your site.

Place an Emergency Call Press an outside line button to dial your local emergency service 
number.
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Using Call Transfer

If you want to... Then...

Answer a Call Lift the handset and press the flashing line button OR 
press the speakerphone button to answer a call.

Answer a Call While on Another Line 1. Press the flashing line button for the incoming 
call. This puts the previous call on hold.

2. Greet the new caller.

3. To return to the previous call, press the flashing 
line button for the call. The second caller will be 
put on hold.

If you want to... Then...

Transfer a Call 1. While on an internal call, press the Transfer 
feature button.

2. Select an intercom and call the number to which 
you want to transfer the call.

3. Announce the call (optional).

4. Press Transfer again or hang up.
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Chapter 3: Using Your Phone
Understanding your Phone Features

Making Conference Calls

Using the Phone KeyPad 

If you want to... Then...

Make a Conference Call 1. Place a call to the first participant. 

2. Press an intercom button or outside line button 
and dial the next participant. This puts the first 
call on hold.

3. When the second participant answers the call, 
press the Conference feature button. The 
conference button lamp on your phone will light 
up green.

4. Press the intercom or line button for the first call. 
The partcipants are now connected in a 
conference call. 
A total of three participants can be connected 
in a call.

Once the call is in progress, the buttons 
for the intercoms or lines involved in the call light up 
green.

To End a Conference Call Hang up. If you created the conference, all 
participants drop and the call ends. Only the 
person who created the conference can end it. 

To Leave a Conference Call If you want to leave a conference call that you 
created, press the Transfer feature button. The other 
call participants will remain on the call (regular 
phone call) until they hang up.

If you want to... Then...

Dial a Phone Number Use the phone keypad to enter numbers on the 
phone screen and access Voicemail and Auto 
Attendant systems.
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Adjusting the Volume
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Using Mute

Using the Speakerphone

Use the Headset Indicator

If you want to... Then...

Adjust the volume control Press the volume control to adjust the volume for the 
handset speaker and the speakerphone.

If you want to... Then...

Use Mute Press the microphone button. When the phone is 
muted, the microphone button LED lights red. To 
unmute the phone, press the microphone button 
again.

If you want to... Then...

Place and receive calls using the 
speakerphone

Press the speakerphone button. The speakerphone 
button enables hands-free calling via the 
speakerphone or headset. This button turns green 
when the speakerphone is on.

If you want to... Then...

Place and receive calls using the headset 1. Plug a headset into the headset port on 
the back of the phone.

2. Press the Headset feature button.

3. Press the speakerphone button to place 
and receive calls using the headset.
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Chapter 3: Using Your Phone
Understanding your Phone Features

Display

Cancel

Using Hold and Resume

If you want to... Then...

Use the Display button Press the Display button to view the button layout 
screen on your PHM1200 IP Phone.

If you want to... Then...

Use the Cancel button Press the Cancel button to cancel the current phone 
task and display the previous screen.

If you want to... Then...

Place a Call on Hold While in a call, press the Hold button on the phone. 
To resume the call, press the line button for the call.
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Using Forward All

Using Redial

If you want to... Then...

Park a Call 1. During a call, press the Park feature button. 
The Park lamp turns green.

2. Note the Call Park phone number displayed on 
your phone screen.

3. Hang up.

To retrieve a parked call 1. Press the Park button again or dial the call 
park number using an intercom from any phone 
on the network. 

If a parked call is not retrieved (within 30 seconds), 
the park lamp display glows red as a reminder for 
a limited time. Once the call is retrieved, the Park 
lamp turns off.

If you want to... Then...

Use Forward All Set Call Forward Always on your phone, the 
Forward All button lights up, press the Forward All 
feature button to toggle call forward on or off.

To set Call Forward on your phone, see 
section”Using Call Forward” on page 20. 

If you want to... Then...

Redial a Number To dial the last dialed extension or an outside 
number, press the Redial feature button.
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Chapter 3: Using Your Phone
Understanding your Phone Features

Using Voicemail

Using System Voice Mail

Using Auto Dial

If you want to... Then...

Access Voicemail The Voicemail feature button allows access to your 
personal voice mailbox. This button lights up when you 
have a voicemail message. See ”Using Voice 
Mail” on page 23.

If you want to... Then...

Access System Voice Mail The System Voice Mail feature button allows you to 
access the system-wide mailbox. See ”Accessing 
Your System Voice Mailbox” on page 28.

If you want to... Then...

Auto Dial a Number 1. Lift the handset and press the Auto Dial button 
for the phone number or intercom you want to 
call.

2. To use the speakerphone, simply press the Auto 
Dial button without lifting the handset.

The Auto Dial button corresponds to an Auto Dial 
number set by you. See ”Setting Auto Dial 
Numbers” on page 32.
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Using Operator

Using Operator Do Not Disturb

If you want to... Then...

Enable or Disable the After Hours Greeting 
(Button 15)

The After Hours feature button allows you to 
manually override the After Hours greeting. This 
feature may not be available to you. See ”Enabling 
the After Hours greeting” on page 38.

If you want to... Then...

Answer Operator Calls The Operator feature button is enabled by your 
phone administrator. This feature may not be 
available to you. See ”Managing Operator Calls” on 
page 39.

If you want to... Then...

Use Operator Do Not Disturb The Operator Do Not Disturb button is enabled by 
your phone administrator. This button allows you to 
opt out of the operator queue. This feature may not 
be available to you. See ”Managing Operator Calls” 
on page 39.
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Using Your Phone Screen

Using Do Not Disturb

Using Your Phone Screen
You can also access basic phone features on your Phone screen (PHM1200 IP Phone model 
only) using the softkeys and navigation button. Some advanced call features that are 
supported may not be available to you and must be enabled by your phone administrator.

Placing a Call

If you want to... Then...

Use Do Not Disturb The Do Not Disturb feature button allows you to 
disable the phone ringer and call waiting features. 
Calls get forwarded on no answer to their related 
destination.

If you want to... Then...

Place an Internal or Outside 
Call

Press the calls softkey and select the New Call button.

Place a Call Using the Call 
History List

1. Press the Tasks softkey.

2. Select Call History.

3. Use the navigation dial to scroll to the number you want to 
call in the Call History List.

4. To place the call, lift the handset and press the center 
navigation button, or simply press the center navigation 
button to place the call on the speakerphone.

Dial from a Local Directory 1. Press the Tasks softkey tab and select Local Directory. 

2. Scroll to the person you want to call and press Dial.
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Using Call Transfer

If you want to... Then...

Place a Call on Hold While in a call, press the Hold button on the phone 
screen. To resume the call, press the line button for 
the call.

If you want to... Then...

Transfer a Call 1. While on an internal call, select the Transfer 
button on the Calls tab.

2. Select an intercom and call the number to which 
you want to transfer the call.

3. Announce the call (optional).

4. Select Transfer again or hang up.



19

Linksys One Communications Solution

C
ha

pt
er

3

Chapter 3: Using Your Phone
Using Your Phone Screen

Making Conference Calls

If you want to... Then...

Make a Conference Call 1. Place a call to the first participant. 

2. Press an intercom button or outside line button 
and dial the next participant. This puts the first 
call on hold.

3. When the second participant answers the call, 
Select the Conference button on the Calls Tab. 
The conference button lamp on your phone will 
light up green.

4. Select Join under the Calls tab for your first 
call. The participants are now connected in a 
conference call. A total of three participants 
can be connected in a call.

When a conference call is in progress, the buttons 
for the intercoms or lines involved in the call light up 
green.

To End a Conference Call Select End Call. If you created the conference, all 
participants drop and the call ends. Only the 
person who created the conference can end it. 

To Leave a Conference Call If you want to leave a conference call that you 
created, select the Transfer feature button. The other 
call participants will remain on the call (regular 
phone call) until they hang up.
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Using Call Forward

Using Voicemail

If you want to... Then...

Park a Call 1. During a call, select the Park button on the 
Calls tab on your PHM1200 IP phone. The 
Park lamp turns green.

To retrieve a parked call 1. Select the Park button again.

If a parked call is not retrieved (within 30 seconds), 
the park lamp display glows red as a reminder for 
a limited time. Once the call is retrieved, the Park 
lamp turns off.

If you want to... Then...

Use Call Forward 1. Press the Tasks softkey tab on your phone and 
choose Set Call Forward Always. Select an 
option from the phone menu.

2. When Call Forward Always is active, the 
Forward All button lights up, press the 
Forward All feature button to toggle call 
forward on or off.

To set Call Forward on your User Settings screen. 
See ”Changing Your Call Forward Settings” on 
page 31.

If you want to... Then...

Access Voicemail  Press the Tasks softkey tab on your phone and 
choose Voicemail. See ”Using Voice Mail” on 
page 23.
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Chapter 3: Using Your Phone
Using Your Phone Screen

Using System Voice Mail

Using Support

If you want to... Then...

Access System Voice Mail Press the Tasks softkey tab on your phone and 
choose System Voicemail. See ”Accessing Your 
System Voice Mailbox” on page 28.

If you want to... Then...

Display Support information Press the Tasks softkey tab on your phone and 
choose Support to display site and phone 
information
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Chapter 4: Using Voice Mail
Accessing Personal Voice Mail Using Voice Prompts

Using Voice Mail 
The Linksys One IP phones include an integrated voice mail application for high-quality 
voice messaging services. You can access voice mail from your phone using the Voice Mail 
menu on your phone screen, or from any phone using the voice mail prompts. When you 
receive a new message, the message waiting indicator lights up on your phone and a 
stuttered dial tone is played when you go off hook (if configured). 

This section provides procedures for accessing and managing your personal and system 
voice mailbox. The following topics are covered:

• ”Accessing Personal Voice Mail Using Voice Prompts” on page 23

• ”Accessing Voice Mail Using the Phone Screen” on page 24

• ”Managing Your Personal Voice Mailbox” on page 25

• ”Accessing Your System Voice Mailbox” on page 28

Accessing Personal Voice Mail Using Voice Prompts
Using an Intercom Button:

1. Select an intercom on your phone and dial your voice mail phone number. Your voice 
mail number is your intercom extension plus 100.

Intercom = 210

Voice Mail Number = 310

For security purposes, it’s a good idea to change your password the first time you login to 
your voice mail. See ”Changing Your Voice Mail Password” on page 27.

2. Follow the voice prompts to record your name, access voice mail and change personal 
settings.
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Using an Outside Phone

• From an outside phone, access the Auto Attendant and dial your voice mail number.
24
Accessin

Using the Voice Mail Feature Button:

1. Press the Voice Mail feature button.

2. Follow the voice prompts to record your name, access voice mail, and change personal 
settings.

Accessing Voice Mail Using the Phone Screen
On your PHM1200 IP phone screen: 

1. Press the Tasks softkey tab and select Voice Mail.

2. On the Voice Mail menu, select the desired Voice Mail option.

See table below for options that are available to you on the Voice Mail menu (you can click 
the back arrow on the navigation dial to return to the previous menu):

NOTE: If you have a private line, you 
can access the Auto Attendant remotely 
by modifying the call forward 
destination on your User Settings screen. 
See ”Changing Your Call Forward 
Settings” on page 31. Otherwise, 
contact your phone administrator for 
information on accessing the Auto 
Attendant.

Option Description Action

New Messages Displays a list of new 
messages in your voice 
mailbox, including the caller 
ID, date and time stamp, and 
length of the message.

1. Click the Play tab to listen to the message 
or click the Save tab to save the 
message.

2. Press the forward navigation key for 
advanced message handling options.
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Chapter 4: Using Voice Mail
Managing Your Personal Voice Mailbox

Managing Your Personal Voice Mailbox
The following sections help you set up your voice mail using the phone screen interface on 
your PHM1200 IP phone:

• ”Recording Voice Mail Greetings” on page 26

• ”Recording Your Name” on page 26

• ”Changing Your Voice Mail Password” on page 27

• ”Changing Voice Mail Notification Settings” on page 27

If you want to set up your voice mail using voice prompts, see ”Accessing Personal Voice 
Mail Using Voice Prompts” on page 23.

Saved Messages Displays a list of the saved 
messages in your voice 
mailbox, including the caller 
ID, date and time stamp, and 
length of the message.

Click the Play tab to listen to the message or 
click the Trash tab to send the message to the 
Trash. You can still access this message from 
the Trash menu option. Press the forward 
navigation key for advanced message 
handling options.

Trashed Messages Displays a list of messages 
you have sent to the trash, 
including the caller ID, date 
and time stamp, and length 
of the message.

Click the Play tab to listen to the message or 
click the Shred tab to completely erase the 
message. Press the forward navigation key 
for advanced message handling options. 

Voice Mail 
Options

Displays menu items for 
recording greetings, 
changing personal settings, 
and changing notification 
settings.

See ”Managing Your Personal Voice 
Mailbox” on page 25 for details on how to 
use the Voice Mail Options menu. Press the 
forward key for advanced message handling 
options. 

Option Description Action
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Recording Voice Mail Greetings
26
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You can record two types of greetings: a Primary Greeting and an Alternate greeting.

1. On your phone, press the Voice Mail feature button or press the Tasks softkey tab and 
select Voice Mail.

2. On the phone screen, use the navigation dial to highlight and select Options.

3. Select Greetings.

4. Select Primary Greeting.

5. Press the Record softkey.

6. Follow the instructions on the screen to record your primary greeting.

7. Press the Play softkey to playback your greeting. If you’d like to re-record it, press the 
Record softkey again and follow the instructions on the screen.

8. When you are satisfied with your greeting, highlight and select Primary Greeting to set 
this as the message that callers will hear. You’ll see a green check mark next to the 
Primary Greeting menu option.

9. If desired, record an alternate greeting. Perform the same steps above, selecting 
Alternate Greeting instead of Primary Greeting.

Recording Your Name

1. On your phone, press the Voice Mail feature button or press the Tasks softkey tab and 
select Voice Mail.

2. On the phone screen, use the navigation dial to highlight and select Options.

3. Select Personal Settings.

4. Select Recorded Name.

5. Press the Record softkey.

6. Follow the instructions on the phone screen to record your name. When recording is 
complete, the phone screen displays “Recording Successful!”.
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Managing Your Personal Voice Mailbox

7. Press the Play softkey to playback your recorded name. If you’d like to re-record it, press 
the Record softkey again and follow the instructions on the screen.

Changing Your Voice Mail Password

1. On your phone, press the Voice Mail feature button or press the Tasks softkey tab and 
select Voice Mail.

2. Select Options.

3. Select Personal Settings.

4. Select Change Password.

5. Enter a new password and press the Enter softkey.

6. Confirm your new password and press Enter again.

Changing Voice Mail Notification Settings

When you have a new voice mail message in your voice mailbox, the message waiting 
indicator on the phone handset lights up red and you’ll also hear a “stutter” dialtone when 
you go off hook. If desired, you can disable the stutter dialtone notification as follows:

1. On your phone, press the Voice Mail feature button or press the Tasks softkey tab and 
select Voice Mail.

NOTE: You must record a name to 
appear in the Auto Attendant directory 
for callers searching by name.

NOTE: Your voice mail password is the 
same password you use to access your 
User page. Therefore, if you change it 
here, you’ll need to use the new 
password to log in to your User page. 
See ”Login To Your User Page” on 
page 29.
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2. Select Notification Settings.

3. Select the Disable tab to clear the checkbox next to Stutter Dialtone.
28
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You can enable the stutter dialtone notification at any time by selecting the Enable tab on the 
Notification Settings phone screen.

Accessing Your System Voice Mailbox
Each Linksys One phone has one system voice mailbox. However, additional mailboxes can 
be enabled if desired. Your phone administrator can assign a maximum of 4 system voice 
mailboxes on your phone. You can access your system voicemail as follows:

Using an Intercom Button:

1. Select an intercom on your phone and dial the default extension 301 (or the extension 
number for your system-wide mailbox as applicable).

Using an Outside Line:

• From an outside line, access the Auto Attendant and dial extension 301 (or the 
extension number for your system-wide mailbox as applicable).

Using the System Voice Mail Feature Button:

1. Press the System Voice Mail feature button to access your system-wide mailbox.

NOTE: If you have a private line, you 
can access the Auto Attendant remotely 
by modifying the call forward 
destination on your User Settings screen. 
See ”Changing Your Call Forward 
Settings” on page 31. Otherwise, 
contact your phone administrator for 
information on accessing the Auto 
Attendant.
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Using Your User Page
Although most system settings are already set for you, you can control some phone features 
and settings on your User Page using the web browser on your computer. Once you define 
your phone settings, you can access them on your phone.

This section describes how to access your User Page and related screens. The following 
topics are covered:

• ”Login To Your User Page” on page 29

• ”Changing Your User Account Password” on page 30

• ”Changing Your Call Forward Settings” on page 31

• ”Setting Auto Dial Numbers” on page 32

• ”Viewing Phone Button Assignments” on page 33

• ”Installing the Button Template on Your Phone” on page 34

Login To Your User Page
1. Open a browser on a DHCP-enabled computer that is connected to your phone and 

type: 

https://192.168.100.1

OR

https://phoneadmin

2. When presented with a login screen, enter the following information: 

User: <3-digit phone extension> 

Password: <3-digit phone extension + 100> by default
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Changing Your User Account Password 
30

The first time you access your User page you will be prompted to change your password.

For security purposes, it’s a good idea to change your password the first time you login to 
the User page or the first time you access voice mail.

Here’s how to change the password for your User page. You can also change your 
password from the Voice Mail menu on the phone screen. See ”Changing Your Voice Mail 
Password” on page 27.

1. Login to your User web page.

2. Click on Accounts.

3. In the Password Change section, type your old and new password. For password 
verification, type your new password again.

4. Click the button to save your changes. Your password will be updated 
immediately.

Accessing Your User Settings
Use your web-based User Settings screen to set your call forwarding options and change 
the name assigned on your phone. To access your User Settings screen:

1. Login to your User web page. 

2. Click on Phone Applications.

3. Click on User Settings.

NOTE: If you change your password 
on your User page, you are also 
changing it for your voice mail (and 
vice-versa).
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ard Description

rd All calls are forwarded to the specified 
destination before ringing. 

rd If the user’s extension is busy or there 
is no answer, calls are forwarded to 
the specified destination.

rd 
n Description

ant All Incoming calls are forwarded to the 
Auto Attendant.

ice All Incoming calls are forwarded to 
your personal voice mailbox.

Unanswered calls on this line are 
forwarded to the system operator.

f Calls are forwarded to the intercom 
number set here.

f All incoming calls are forwarded to the 
voice mail of the Intercom number set 
here.

All incoming calls are forwarded to the 
company’s voice mailbox or one of the 
four system voice mailbox.
Chapter 5: Using Your User Page
Accessing Your User Settings

Changing Your Call Forward Settings

You can personalize your call forward destinations on your User Settings screen. Two call 
forwarding options are available: Call Forward Always and Call Forward Busy or No 
Answer.

To change your Call Forward Always settings:

1. Open your User Settings screen. 

2. Click . 

3. Click the Call Forward Always checkbox.

4. Choose a call forward destination from the drop down box (see table).

5. Click . Your changes take effect immediately.

NOTE: Call Forward Always and Call 
Forward No Answer affect all intercoms 
and lines.

NOTE: If your phone administrator has 
already configured call forward settings 
for you, the call forward destinations 
will not be available on the User 
Settings screen.

NOTE: You can also personalize your 
Call Forward Always setting from the 
phone screen. See "Using Your Phone 
Screen” section for more information.

Call Forw
Option

Call Forwa
Always

Call Forwa
Busy or
No Answer

Call Forwa
Destinatio

Auto Attend

Personal Vo
Mail

Operator

Intercom O

Voicemail o

VM_System
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To Forward Busy or No Answer calls:

1. Open your User Settings screen. See ”Accessing Your User Settings” on page 30.
32

2. Click . 

3. Choose a Call Forward Busy or No answer destination from the drop down box (see 
table).

4. Click . Your changes take effect immediately.

Setting a Name

The First Name and Last Name fields set the name you want associated to your extension in 
the Auto Attendant directory. This is also the name that appears on your phone screen. To 
change this setting, enter the edit mode and then type a new first name and last name. Click 
commit to save your changes.

Accessing Your User Template
Use your web-based User Template screen to customize Auto Dial features that are 
available on your phone. 

To access your User Template Screen:

1. Login to User Page. 

2. Click on Phone Applications.

3. Click on User Template.

Setting Auto Dial Numbers

You can assign frequently dialed extensions and phone numbers to the buttons on your 
phone using the User Template screen. This screen is divided into two areas: the Template 
area and the Unused area. The Template area (located on the left side) shows the current 
phone and Auto Dial feature assignments. The Unused area (located on the right side) shows 
the features and autodial settings that are available but not currently in use. 
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To set Auto Dials for inside or outside phone numbers:

1. Open your User Template screen. See ”Accessing Your User Template” on page 32.

2. Click . 

3. When you are finished, click .

To restart the phone immediately, click Commit and Restart Phone. Otherwise, the phone 
automatically restarts during the next scheduled maintenance window.

Viewing Phone Button Assignments

You can view phone button assignments from your phone or from your User Template screen 
as follows:

On your phone:

• Press the Display button followed by any button on the phone. The feature assigned to 
that button is displayed at the top of your phone screen.

• You can also see which features are assigned to your phone buttons on the Tasks > 
Button Layout phone screen menu.

On Your User Template Screen:

1.  Open your User Template screen.

2. Click the Print/See Template button at the top of the page.

Printing Your Phone Button Template

The phone button template lists intercoms, private lines, Auto Dials and features configured 
for your phone. Here’s how to print the phone button template and install it on your phone.

1.   Open your User Template screen.

2. Click the Print/See Template button at the top of the page.

To print the template using the Internet Explorer browser:

• On your browser menu bar, choose Tools > Internet Options.
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• On the Advanced tab, scroll down to the section titled Printing. 

• Check the box Print Background Colors and Images and click OK.
34

• Choose File > Print from your browser menu bar.

• Select the desired printer options and print the template.

To print the template using the Firefox browser:

• On your browser menu, choose File > Page Setup

• Choose Format and Options tab, click on the Print Background checkbox.

Installing the Button Template on Your Phone

1. Trim the phone button template so that it fits on your phone.

2. Remove the plastic cover over the current button template on your phone.

3. Insert the new phone button template.

4. Replace the plastic cover.
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Using the Auto Attendant 
The Linksys One IP phones include an Auto Attendant application that helps callers to 
quickly reach the right person or hear information they need without the assistance of an 
operator 24 hours a day, 7 days per week.

This section provides procedures for accessing and administering the Auto Attendant 
application. The following topics are covered:

• ”Accessing the Auto Attendant” on page 35

• ”Managing the Auto Attendant” on page 35

Accessing the Auto Attendant
The Auto Attendant application integrates with the office directory, allowing callers to reach 
their intended party using 'dial by name or extension number' functionality. The Auto 
Attendant also features the ability for callers to talk "Live" to an Operator by pressing '0' in 
response to an Auto Attendant query. 

You can access the Auto Attendant application by dialing the intercom or extension 201 and 
following the voice prompts. 

Managing the Auto Attendant
 To manage the Auto Attendant greetings and password, you will have to have
administrative access to the Auto Attendant application. This is controlled
by your phone administrator.

If you do have administrative access, you can access the Auto Attendant Administration 
extension as follows:

• Dial intercom 209 and following the voice prompts 

• Use the Tasks > Auto Attendant menu on your PHM1200 IP Phone.

• Selecting the After Hours feature button (if enabled on your phone by your phone 
administrator; disabled by default). 
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You can then refer to the following sections for managing the Auto Attendant:

• ”Recording the Auto Attendant Greeting” on page 36
36

• ”Enabling the After Hours greeting” on page 38

• ”Changing the Auto Attendant password” on page 39

Recording the Auto Attendant Greeting

You can change the greeting the Auto Attendant plays to callers before presenting the menu 
options. For example, you may want to greet the caller with your company name before 
presenting the menu options. You can record a Main greeting and an After Hours greeting 
for the Auto Attendant. 

To record a greeting using the PHM1200 phone screen interface:

1. Select Tasks > Auto Attendant from your phone screen.

2. Type the password for the Auto Attendant. The first time you access the Auto Attendant 
the default password is set to 209. See ”Changing the Auto Attendant password” on 
page 39.

3. To record the Main greeting, select Main Greeting on the Auto Attendant phone screen.

4. Press the Record softkey.

5. Follow the instructions on the phone screen to record the greeting you want callers to 
hear during regular business hours. When recording is complete, the phone screen 
displays “Recording Successful!” and returns to the Auto Attendant phone screen.

6. Press the Play softkey to playback your greeting. If you’d like to re-record it, press the 
Record softkey again and follow the instructions on the screen.

7. To enable the Main Greeting, select Main Greeting on the Auto Attendant phone screen. 
When enabled, a green check mark displays next to Main Greeting.

8. To record the After Hours greeting, follow steps 1-7 above, selecting After Hours 
Greeting instead of Main Greeting.
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To record a greeting using the Auto Attendant voice prompts for your IP phones:

1. Do one of the following:

• Open an intercom on your phone and dial the Auto Attendant Administration 
extension (209)

• From an outside line, use the Auto Attendant to transfer to the Auto Attendant 
administration extension (209)

.

2. Type the password for the Auto Attendant. The first time you access the Auto Attendant 
the default password is set to 209. See ”Changing the Auto Attendant password” on 
page 39.

3. Follow the voice prompts to record a Main greeting and an After Hours greeting.

NOTE: If you have a private line, you 
can access the Auto Attendant remotely 
by modifying the call forward 
destination on your User Settings screen. 
See ”Changing Your Call Forward 
Settings” on page 31. Otherwise, 
contact your phone administrator for 
information on accessing the Auto 
Attendant.
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Enabling the After Hours greeting
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Your phone administrator defines the times that the Auto Attendant plays the Main Greeting 
and the After Hours greeting. However, you can override this setting by pressing the After 
Hours button or by choosing a greeting from the Auto Attendant phone menu on your 
PHM1200 phone as follows:

1. Open the Auto Attendant menu on your phone screen and select the greeting you want 
to play: Main Greeting or After Hours. A green checkmark indicates which greeting is 
currently enabled.

NOTE: When you override the Auto 
Attendant greeting, your setting stays in 
affect until the next greeting window 
defined for your phone system. Contact 
your phone administrator for 
information on the greeting windows 
defined for your phone system.
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Changing the Auto Attendant password

To change the Auto Attendant password:

1. Do one of the following:

• Open an intercom on your phone and dial the Auto Attendant Administration 
extension (209).

• From an outside line, access the Auto Attendant and enter your Auto Attendant 
Administration extension (209) when prompted.

2. Choose option 3 from the Auto Attendant voice prompt menu.

3. Follow the voice prompts to change the password.

Managing Operator Calls
Your phone administrator can add you as a "Live" Operator; this enables the Operator, 
Operator DND and System Voice Mail feature buttons on your phone. When a caller 
presses zero in response to an Auto Attendant prompt or gets transferred to the operator 
(via extension 200), the calls get routed to your phone or multiple phones that are assigned 
as operators in the list. You can opt out of the list by selecting the Operator DND (do not 
disturb) button. You can also access messages using the System Voice Mail feature button.

NOTE: If you have a private line, you 
can access the Auto Attendant remotely 
by modifying the call forward 
destination on your User Settings screen. 
See ”Changing Your Call Forward 
Settings” on page 31. Otherwise, 
contact your phone administrator for 
information on accessing the Auto 
Attendant.
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A Linksys One Contact Information
Need to contact Linksys One?

Visit us online for information on the latest products and updates to your existing products 
at:

Can’t find information about a product you want to buy on the web? Do you want to know 
more about networking with Linksys One products? Give our advice line a call at:

Don't wish to call? You can e-mail us at:

Normal business hours are from 8 am - 5 pm Central Time, Monday - Friday. 

If you experience problems with any Linksys One product, you can call us at:

Don't wish to call? You can e-mail us at:

You can reach Linkys One technical support 24 hours a day, 7 days a week.

If any Linksys One product proves defective during its warranty period, you can call the 
Linksys One Return Merchandise Authorization (RMA) department for obtaining a Return 
Authorization Number at:

Don't wish to call? You can e-mail us at:

(Details on Warranty and RMA issues can be found in the Warranty Information section in 
this Guide.)

www.linksysOne.com

866-870-5826

www.linksysOne.com

866-870-5826

www.linksysOne.com

866-870-5826

www.linksysOne.com
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